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[Abstract] Maturation of secretory granules is a crucial process that ensures the bioactivity of cargo 

proteins undergoing regulated secretion. In Drosophila melanogaster, the larval salivary glands produce 

secretory granules that are up to four-fold larger in cross-sectional area after maturation. Therefore, we 

developed a live imaging microscopy approach to quantitate the size of secretory granules with a view 
to identifying genes involved in their maturation. Here, we describe the procedures of larval salivary 

gland dissection and sample preparation for live imaging with a fluorescence confocal microscope. 
Furthermore, we describe the workflow for measuring the size of secretory granules by cross-sectional 

surface area and statistical analysis. Our live imaging microscopy method provides a reliable read-out 
for the status of secretory granule maturation in Drosophila larval salivary glands. 
Keywords: Drosophila, Genetics, Organelle biogenesis, Live microscopy, Image analysis 
 
[Background] Regulated secretion is a process during which biologically active molecules such as 

hormones, digestive enzymes, and mucus are secreted from specialized secretory cells in a coordinated 

manner. Hence, regulated secretion is critical for maintaining physiological homeostasis in animals. 
Examples include the release of insulin after a meal, the release of mucin in response to pathogenic 

microorganisms, and the release of sweat during elevated body temperature. These biologically active 
molecules are produced by endocrine or exocrine cells and stored in long-lasting secretory organelles 

termed secretory granules. 
  Biogenesis of secretory granules begins at the trans-Golgi network, where cargoes of secretory 

granules aggregate and bud off as immature secretory granules (Tooze, 1991 and 1998; Borgonovo   
et al., 2006). Immature secretory granules then undergo a maturation process to become fully functional 

and competent for secretion. The maturation process includes homotypic fusion of immature secretory 
granules, removal of unwanted materials, and processing of cargoes (Tooze, 1991; Arvan and Castle, 

1998). Failure of secretory granules to mature can lead to reduced bioactivity of their cargoes. For 
example, most hormones enter immature secretory granules as inactive prohormones. During 

maturation, the lumen of secretory granules is acidified, and prohormone convertases cleave 
prohormones into biologically active hormones (Moore et al., 2002). Therefore, failed granule maturation 

can have physiological consequences, leading to reduced activity or inefficient secretion of cargo 
proteins. 
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  Although secretory granule maturation is a critical step in regulated secretion, assays for secretory 

granule maturation are not simple. Transmission electron microscopy is one of the standard methods to 
assay secretory granule maturation. Secretory granules are electron dense in electron micrographs 

(Nitsch and Rinne, 1981; Tatsuoka and Reese, 1989). Reduced secretory granule maturation is often 
correlated with a reduction in electron density or in secretory granule number (Edwards et al., 2009; Cao 

et al., 2013; Du et al., 2016; Emperador-Melero et al., 2018; Hummer et al., 2017; Rao et al., 2020). If 

antibodies are available, a decrease in hormone secretion or an increased ratio of prohormone to 

hormone can be measured in blood plasma or cell culture media by western blotting and densitometry 
or ELISA following stimulation (Cao et al., 2013; Du et al., 2016; Hummer et al., 2017). 

Immunofluorescence using a combination of anti-prohormone antibodies and secretory granule markers 
can also reveal defects in hormone processing, as indicated by an increase in intensity of the 
prohormone signal (Bogan et al., 2012; Cao et al., 2013). 
  The Drosophila larval salivary gland is a powerful genetic model for studying secretory granule 

biogenesis (Biyasheva et al., 2001; Burgess et al., 2011 and 2012; Torres et al., 2014; Csizmadia et al., 
2018; Ma et al., 2020; Neuman et al., 2020). The larval salivary glands start producing glue protein-

containing secretory granules 24 h after entry into the third instar larval stage. Immature secretory 
granules then mature over the next 18 h and are secreted all at once in response to a pulse of the 
hormone ecdysone (Biyasheva et al., 2001; Burgess et al., 2011). The secreted glue proteins adhere 

pupal cases onto a solid surface during metamorphosis. Size differences between immature and mature 
secretory granules can be 2- to 4-fold in cross-sectional surface area (5 μm2 vs. 10-25 μm2) (Ma et al., 
2020). Thus, the Drosophila larval salivary gland is an excellent system to identify genes required for 

secretory granule maturation. 
  The Andres laboratory previously generated transgenic lines expressing one of the glue proteins 
(Sgs3) tagged with GFP or DsRed under the control of its endogenous promoter (Biyasheva et al., 2001; 
Costantino et al., 2008). Using these lines, secretory granules can be visualized by confocal microscopy. 

Our laboratory has used these transgenic lines in combination with a salivary gland-specific Gal4 driver 
and UAS-controlled RNAi transgenic lines to identify genes needed for secretory granule maturation. 

Here, we provide a detailed protocol for visualizing secretory granules via live imaging with a spinning-
disc confocal microscope. Acquired data are analyzed with the imaging software Volocity 6.3 to 

quantitate secretory granule size. Secretory granule size distribution is then used as a readout for 
secretory granule maturation in the Drosophila larval salivary gland. 

 
Materials and Reagents 
 

1. Microscope slides 75 × 25 × 1 mm (VWR, catalog number: 16004-368) 

2. Glass coverslips 18 × 18 mm No. 1.5 (VWR, catalog number: 48366-205) 
3. Self-adhesive reinforcement labels (Avery, catalog number: 32203) 

4. Syringe 5 ml (BD, catalog number: 309603) 
5. Needle 18 G or lower (BD, catalog number: 305195) 

http://www.bio-protocol.org/e4039
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6. Dissection needle (Fisher Scientific, catalog number: 13820024) 

7. Petri dishes 100 × 15 mm (VWR, catalog number: 25384-088) 
8. Petri dishes 35 × 10 mm (Corning, catalog number: 351008) 
9. P{w+, Sgs3-GFP} (Bloomington Drosophila Stock Center, catalog number: 5884, 5885) or P{w+, 

Sgs3-DsRed} (Andres lab, University of Nevada, Las Vegas, USA) 3rd instar larva 

10. High-vacuum M grease 100 g (Apiezon, Sigma, catalog number: Z273589) 
11. Pipette tips (P200) 

12. SYLGARDTM 184 Silicone Elastomer Kit 0.5 kg (Dow Chemical, Sigma, catalog number: 
4019862) 

13. KCl (Sigma, catalog number: P3911-500G) 
14. NaCl (Bio Basic, catalog number: CA99501-558) 

15. CaCl2·2H2O (Sigma, catalog number: C-5080-500G) 
16. Tris-HCl (VWR, catalog number: 0234-1KG) 
17. Drosophila Ringer’s solution (see Recipe 1) 

18. Silicone dissection plate (see Recipe 2) 

 
Equipment 
 

1. Dumont #5 fine forceps (Fine Science Tools, catalog number: 11251-20) 

2. Stereomicroscope (Leica Microsystems, model: Leica MZ6) 
3. Spinning-disc confocal coupled with an Olympus IX81 microscope (Quorum Technologies, 

Puslinch, Ontario, Canada) 
 

Software 
 

1. Volocity 6.3 (Quorum Technologies, Puslinch, ON, Canada) 
2. Adobe Creative Cloud Photoshop (Adobe, San Jose, CA, USA) 
3. Microsoft Office 365 Excel (Microsoft, Redmond, WA, USA) 
 

Procedure 
 

A. Dissection and sample preparation 
1. Pick 3rd instar wandering larvae with a dissection needle and transfer to a 35-mm Petri dish with 

Drosophila Ringer’s solution. Use fine forceps to hold the larvae and swirl in Drosophila Ringer’s 

solution to wash off any food. 3rd instar wandering larvae are those moving away from the food 

source; they can be easily located on the side of vials or bottles housing flies.  
Note: It is best to pick larvae that are still moving and have food left in the gut. If molasses is 

included in the Drosophila food recipe, food in the gut can easily be identified by the dark brown 

color in the middle of the larvae. Otherwise, consumer food coloring can also be added to the 
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Drosophila food to help identify larvae in the right stage. Larvae that have stopped moving or 

have no food left in the gut are ready to pupariate; therefore, their secretory granules would be 

secreted and would not be useful in determining secretory granule size. 

2. Transfer individual clean larva with fine forceps to a droplet of Drosophila Ringer’s solution (50 

μl) on a silicone dissection plate. 
3. Dissect the larva under a stereomicroscope with fine forceps. Immobilize the larva by gently 

holding it down with forceps using the non-dominant hand. Pinch the mouth hook of the larva 

with the dominant hand and pull to remove the salivary glands. 
4. Clean unwanted tissues away from the salivary glands using forceps (Figure 1A) and mount the 

samples as demonstrated in the illustration (Figure 1B and 1C). 
 

 
Figure 1. Mounting of Drosophila Larval Salivary Glands for Live Microscopy. A. DIC 

image of a larval salivary gland (translucent) with accompanying fat body (opaque) taken with 
10× objective. B. Mounting of larval salivary glands on microscope slide with self-adhesive 

reinforcement label. C. Mounting of larval salivary glands on microscope slide with vacuum 
grease. 

 
5. Mounting the samples with self-adhesive reinforcement labels is fast and consistent (Figure 1B, 

step 6). However, to prevent anoxia, samples should be mounted with vacuum grease if a longer 
imaging time (>30 min) is desired (Figure 1C, step 7). 

6. Place one self-adhesive reinforcement label on the microscope slide. Ensure that the label 
completely adheres to the slide. Pipette 8 µl Drosophila Ringer’s solution to the middle of the 

label. Transfer salivary glands to the solution (3-5 pairs of salivary glands per label). Place cover 
slip on and seal the slide with quick-drying nail polish. Samples are good for up to 30 min 

(following 10 min dissection time). 
7. Dispense vacuum grease into a 5-ml syringe. Use a needle with a small gauge number. 

Dispense vacuum grease by drawing a square on the microscope slide using the syringe. Leave 
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a small gap and do not complete the square. Pipette 30 µl Drosophila Ringer’s solution into the 

middle of the square. Transfer salivary glands to the solution (up to 8 pairs). Place cover slip on 
and gently push down with fine forceps until the vacuum grease seals the sample. Seal the slide 

with quick-drying nail polish. Samples are good for up to 50 min (following 10 min dissection 
time). 

 
B. Imaging 

1. Transfer slide to the stage of spinning-disc confocal microscope. 
2. Open Volocity 6.3 in acquisition mode. Image samples with the 60× objective. Use 

corresponding setting to acquire images in the green or red channel for Sgs3-GFP or Sgs3-
DsRed, respectively. 

3. Capture 20 μm in Z with 0.3 µm per slice. Image at least three representative cells for each pair 
of glands (Figure 2). 

 

 
Figure 2. Secretory Granules of Drosophila Larval Salivary Glands. A representative 

spinning-disc confocal image of one Z-slice of a Drosophila larval salivary gland cell expressing 

the secretory granule marker Sgs3-DsRed. 

 
4. Image at least three independent glands for each genotype. 

 
Data analysis 
 
A. Quantitation and Statistical Analysis 

1. Launch Volocity 6.3 in analysis mode. Open the files saved from acquisition. Create a point 
spread function (PSF) file for deconvolution (Actions > Create New > Calculated PSF…). Enter 

values corresponding to the acquisition setup (Figure 3A).  
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Figure 3. Deconvolution in Volocity 6.3. A. Settings for creating a new point spread function 

file to perform deconvolution on data from the red channel in Volocity 6.3. Values may need to 

be adjusted for a different setup. Here, the objective magnification is increased by 1.5-fold (60× 
to 90×) because the detector used in our system further magnifies the image by 1.5-fold. B. 

Deconvolved data will be listed as a new channel in Volocity 6.3. 
 

2. Run deconvolution on acquired data (Tools > Iterative Restoration…). Set the confidence limit 

to 99% and the iteration limit to 30. A new channel (deconvolved data) will be generated in the 

right panel (Figure 3B). 
3. Split the Z-stacks into individual images (Tools > Split Volumes, select Organize the images into 

folders; Figure 4A). A new folder containing two subfolders will be generated in the left panel 

(Figure 4B). Perform analysis on deconvolved images in the second subfolder. 

 

 
Figure 4. Split Volumes. A. Split volume function to organize Z-slices from raw data and 

deconvolved data into different folders. B. Folders of images created to the left panel of Volocity 
6.3 after split volume function. 

 
4. Select the first image (z = 1) and go to the Measurements tab. Drag Find Objects and Separate 

Touching Objects tasks to the measurement protocol panel at the top of the screen (Figure 5). 

Make sure the two tasks are under the same protocol, generating only one population of 

measurements. 

http://www.bio-protocol.org/e4039
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5. Click the gear icon beside the Find Objects function. For the Threshold, using drop down menu, 

select Automatic. In the Offset threshold by field, enter -10%. In the Minimum object size field, 
enter 4 μm2. Press OK. Under the Separate Touching Objects function, enter 12 μm2 in the 

Object size guide field (Figure 5). This setting works well for secretory granules in wild-type 

salivary glands. The values need to be adapted for genotypes with very large or very small 

secretory granules.  
 

 
Figure 5. Functions to Measure Secretory Granules. A screen shot displaying a protocol 

containing Find Objects and Separate Touching Objects in Volocity 6.3 (top left). Settings for the 
Find Objects function by thresholding (bottom right). 

 
6. Click Measure under the function generated from steps 4 and 5. Check Intensity and Volume 

measurements and press OK. Identified objects will be outlined in the color chosen in the 

protocol created from steps 4 and 5 (Figure 6A). A list of objects should be populated in the 
bottom right panel (Figure 6B). The function can be saved (Measurements > Save Protocol…) 
and later restored (Measurements > Restore Protocol…). 

 

http://www.bio-protocol.org/e4039
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Figure 6. Measuring Secretory Granule Size. A. Secretory granules (red) outlined in purple 

using the protocol described in steps 4-5. B. Output of secretory granule cross-sectional area. 

 
7. Go to the list of objects. Double click on the Area (μm2) tab until the objects are sorted by size 

in descending order. Select all the data excluding the those that are less than 4 μm2. Copy the 
data and paste into Excel 365 for statistical analysis. 

8. Repeat Steps 4-7 for z = 10 and z = 20 to account for variability in secretory granule cross-
sectional area throughout the cell. If the measurement protocol was saved, steps 4-5 can be 
avoided by the Restore Protocol… function described in step 6. 

9. Repeat Steps 4-8 for three representative cells from the same salivary gland. 

10. Repeat Steps 4-9 for three independent salivary glands for each genotype. 
11. Pool all the data for each genotype in Excel 365.  
12. Box plots (Insert > Insert Statistic Chart > Box and whisker plot) can be used to visualize the 

distribution of secretory granule size by cross-sectional surface area (Figure 7). 

 

 
Figure 7. Box Plot Showing Secretory Granule Size Distribution. Distribution of secretory 

granule sizes by cross-sectional area in wild type salivary glands. Each line of the box from 
bottom to top represents the 25th, 50th (median), and 75th percentile of the population. X denotes 
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the mean of the sample. Bottom and top whiskers represent minimum and maximum values 

determined by 1.5× the interquartile range. Dots outside of the whiskers are samples considered 
as statistical outliers. n = 1597 secretory granule cross-sections from 3 salivary gland cells (3 

Z-slices from each cell for a total of 9 Z-slices). 
 

13. t-Test (Data > Data Analysis > t-Test: Two-Sample Assuming Unequal Variances) can be used 

to evaluate the statistical difference in secretory granule cross-sectional area between two 

genotypes. 
 

Recipes  

 
1. Drosophila Ringer’s solution (pH 7.2) 

KCl            182 mM 
NaCl           46 mM 

CaCl2·2H2O    3 mM 
Tris-HCl       10 mM 

2. Silicone dissection plate 
a. Mix the base and curing agent from the SYLGARD 184 kit (10:1, weight:weight) directly in 

a 100-mm Petri dish with a spatula. All procedures should be conducted in a fume hood. 
b. Allow to cure inside the fume hood for 48 h. 
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